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關於 i-Tree（About i-Tree） 

i-Tree是來自美國林務局最先進的同儕評閱（peer-reviewed）軟體套件，其提供

都市及社區林業分析與效益評估工具。i-Tree 工具藉由量化環境樹木提供的服

務及評估都市林結構，以幫助各種大小的地區加強他們的都市林管理與推廣

度。 

 

i-Tree已被社區、非營利組織、顧問、志工及學生用於記錄各種規模的都市

林，從單一樹木乃至社區、都市甚至整個國家。透過了解當地樹木實際提供的

生態系服務，i-Tree使用者可連結都市林管理活動、環境品質及社區的可居住

性。無論研究目標為單一樹木或整個森林，i-Tree的基礎資料供你證明價值及

確定優先度以做更有效的決策。 

 

由美國林務局與眾多合作夥伴共同開發，i-Tree設於公共網域上，可向 i-Tree網

站（www.itreetools.org）索取授權。林務局、Davey樹木專家公司（Davey Tree 

Expert Company）、植樹節基金會（Arbor Day Foundation）、市植樹師學會

（Society of Municipal Arborists）、樹木植栽國際協會（International Society of 

Arboriculture）以及 Casey Trees 皆已成為合作夥伴以利未來發展、傳播與為此

套件提供技術支持。 

 

i-Tree產品（i-Tree Products） 

i-Tree軟體套件 5.0版本包含以下各都市林分析工具及應用程式。 

 

i-Tree Eco 提供整個都市林的概況。其使用來自社區隨機分布樣區的現場資料

及當地每小時空氣汙染和氣象資料，以量化都市林結構、環境影響與對社區的

價值。 

 

i-Tree Streets側重於生態系服務及一個都市行道樹族群的結構。它使用一個樣

本或完整普查資料量化並將每棵樹的年度環境與美學效益以美元價格計算，包

含節約能源、改善空氣質量、減少二氧化碳、雨水控制及房地價增幅。 

 

i-Tree Hydro 是第一個針對植被的都市水文模型。其模擬都市林覆蓋變更的影

響，及流域層不透水表面的每小時河流流量和水質。 

 

i-Tree Vue讓你自由使用全國土地覆蓋資料庫（National Land Cover Database，

NLCD）的衛星圖像以評估社區的土地覆蓋，包含樹冠及當前都市林提供的一

些生態系服務。其也可模擬種植方案對未來效益的影響。 

 

i-Tree Species Selector 是一個獨立的工具，用於幫助都市林管理者根據環境功
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能和地理區域選擇最適合的樹種。 

 

i-Tree Storm幫助你在一場嚴重的颶風天災過後，立即以簡單、可靠又有效的

方式評估廣泛的社區損害。它適用於各種社區類型及大小，並提供關於時間與

減輕災害所需資金的資訊。 

 

i-Tree Design 是一個簡易的線上工具，提供一片樹林中單一樹木的評估平台。

此工具連接 Google 地圖，使你了解樹木選擇、樹木大小及放置位置將如何影響

能源使用和其它效益。此工具仍在早期開發階段，更多精密的功能選項會在未

來版本釋出。 

 

i-Tree Canopy 提供一個快速簡便的方法，透過使用適合的 Google Maps 航空圖

像，產生土地覆蓋類型（如，樹木冠蓋）的有效統計性的估計。透過使用這些

資料，都市林管理者可估計樹冠覆蓋、設立樹冠目標，及順利地進行追蹤，且

能為 i-Tree Hydro 和其它需要土地覆蓋資料的專案估計所需數值。 

 

免責聲明（Disclaimer） 

本出版物中所使用之商品、商號或公司名稱僅為提供讀者資訊和便利，並非排

除其它可能適合之任何產品或服務的使用方式，所提及之商品、商號或公司名

稱也非受到美國農業部或林務局的官方認可或批准。標籤「i-Tree Software Suite 

v. 5.0」所發布之軟體，將不提供任何形式的擔保。它的使用受到最終用戶許可

協議（End User License Agreement，EULA）管轄，使用者在安裝前需先同意接

受該協議。 

 

回饋（Feedback） 

i-Tree開發團隊積極尋求關於此產品的任何回饋意見：軟體套件、使用手冊，

或是開發、推廣、支持和精細化的過程。請將評論根據 i-Tree支持頁面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介紹（Introduction） 

Streets（源自專為都市林管理人量身打造的行道樹資源分析工具，Street Tree 

Resource Analysis Tool for Urban Forest Managers，STRATUM）是一個容易上手

的軟體工具，特別著重於都市行道樹，供任何社區記錄及評估都市樹木的效

益。此分析提供基礎資料以改善都市樹木的管理，並幫助社區得到計畫的支持

與資金。Streets 在以下方面評估行道樹林： 

 

Structure（結構）：Streets 會描述物種組成、年齡分佈、物種重要性價值

與都市林樹冠覆蓋，幫助管理人預估未來種植的需求及病蟲害威脅的影

響。 

 

Function（功能）：Streets 的核心能力可分析都市林生態系服務，也就是

該都市林的功能，包含節能、空氣品質改善、雨水管理與二氧化碳減

量。因市容美化而提升的地產價值及其它效益也將被計算。 

 

Values（數值）：Streets 量化都市林提供的環境及其它效益，不管是單位

方面（像是每小時可節約千瓦的電力）或金錢方面。管理成本也可包含

至分析內，以確定樹木的投資報酬率。 

 

Management needs（管理用處）：如果你決定收集關於樹木狀況、維護

需求、公共建設衝突或病蟲害威脅等資料，Streets 的報告可幫助你將此

資訊運用於樹木管理及預算規劃等事務。 

 

使用由 Streets 提供的報告及資訊將可幫助你： 

1) 藉由了解哪些樹種可將樹冠最大化、為社區帶來重要效益，提高投資的

回報率。 

2) 確定你都市林的管理需求以維護並改善樹木健康。 

3) 促進合作伙伴的投資，例如能源節約及減碳。 

4) 透過提高社區生活品質，證明樹木的價值並獲得公眾支持。 

5) 利用年度預算與支出費用資料，對樹木表現進行經濟評估。 

6) 預估管理成本──不單只是效益──以提供一個規劃策略平台。 

 

由於在設計上較為彈性且具高調整性，Streets 不需以 GIS 為基礎，只需基本的

資料庫資料。Streets 的資料庫程序、PDA應用程式或具網路基礎功能的智慧型

手機，皆可用於社區的樣本或完整行道樹普查資料。此外，Streets 可利用任何

現有的行道樹普查資料，只要有物種和胸高直徑資料。資料需照 Streets 的規範

格式化。 

 

所產生的報告可針對整個城市、管理區或特定物種。Streets 使用地區樹木生長
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模型及地區預設成本和效益，且可依照地區要求設定。無論欲保護現有樹木或

增加預算，Streets 可針對你的樹木計畫提供量化依據。你將能回答關於樹木規

劃計畫最重要的問題，像是行道樹的累積效益是否超過其管理成本？ 

 

最先進的研究為 Streets 效益報告提供科學基礎。維護行道樹的效益與成本資料

來自擴展研究與 16個國家型氣候的實驗模擬。更多關於研究方法的資訊，請參

考此網站（www.itreetools. org）所發表的一系列對應不同氣候地區的樹木指南

（Tree Guides）。 

 

關於本手冊（About This Manual） 

本手冊提供建立 Streets 專案所需的所有資訊。我們從安裝軟體開始，之後會介

紹四個專案階段： 

 

第一階段：開始進行（Phase I: Getting started）。在本節中，我們討論需要於 

一開始做出的決定，例如是否將使用現有的普查資料或另建立新的普查資料，

以及新普查資料為街道區段的隨機樣本或所有樹木的完整普查資料。第一階段

也包含你需列入考慮或已持有的一般資料收集，像是都市預算資訊、地段效益

價格與普查資料的道路名稱清單。在此階段，你將規劃你的普查資料，無論是

決定欲收集的資料項目、定義資料項目的類別，或根據 Streets 的要求重新組織

現有的普查資料。若有需要，最後的步驟則是建立一個樣本普查資料。 

 

第二階段：開始執行軟體（Phase II: Getting started with the software）。在此

階段，我們會使用 Streets 軟體輸入在第一階段所收集的資料、設定我們的普查

資料，並設定 PDA應用程式或智慧型手機/平板電腦功能，以利持有這些工具

的研究者使用。 

 

第三階段：實地調查（Phase III: Out in the field）。在此階段是所有階段最困難

的，因為你將派普查人員到現場收集資料並傳回普查資料。本章節著重於使用

具有網路的行動裝置，像智慧型手機、平板電腦或 PDA。 

 

第四階段：回到你的辦公桌：執行 Streets（Phase IV: Back at your desk: 

Running Streets）。在此章節，我們會描述如何運行軟體以得到結果。首先，我

們會從紙張表格、智慧型手機、平板電腦或 PDA傳送資料至桌機，或上傳現有

普查資料，並討論應如何修改普查資料及如何再次檢查這些實地資料。最後，

本章節涵蓋了所有可用的報告，並說明應如何儲存、輸出及列印計算結果。 

 

附錄一：隨機抽樣工具書（Appendix I：Random Sample Workbook）。如果你

在建立一個樣本普查資料，附錄一將提供你使用 ArcGIS 軟體產生隨機街道區
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段的其中一種方法的詳細步驟。 

 

附錄二：錯誤排除（Appendix II：Troubleshooting）。這幾年內，我們注意到

幾個 Streets 使用者的常見錯誤。此附錄說明它們如何發生及應如何解決。 

 

附錄三：病蟲害檢測調查表輸出格式（Appendix III：Formatting Pest Protocol 

Data for Import）。此表格將呈現與 IPED病蟲害評估檢測相關的資料項目及類

別。 
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安裝（Installation） 

 

系統需求（System Requirements） 

桌上型/筆記型電腦的需求（Requirements for desktop/laptop computers） 

最低硬體（Minimum hardware）： 

 1600 MHZ或是更快的處理器 

 512 MB可用記憶體 

 至少 500MB的可用硬碟空間 

 

軟體（Software）： 

 Windows 作業系統 XP SP2或更高（包含Windows 7） 

 Microsoft Excel 

 Microsoft Data Access Component (MDAC） 2.8 或更高（包含於 i-Tree

安裝內） 

 Microsoft .NET 2.0 Framework（包含於 i-Tree 安裝內） 

 Adobe Reader 9.0 

 針對 PDA使用者，Windows XP 需 ActiveSync 4.5 或更高，Vista與

Windows 7 需Windows Mobile 裝置中心或更高（包含於 i-Tree安裝內） 

 Crystal Report 2008 Runtime（包含於 i-Tree安裝內） 

 

實地資料收集儀器的需求（Requirements for field data collection devices） 

智慧型手機、平板電腦及其它具網路功能的行動裝置： 

 網路瀏覽器要有 HTML-5的相容性（最新版本的 Chrome、Firefox 和

Safari；IE9和 10則有限制） 

 

對於相容性裝置的更新列表，請參閱 i-Tree論壇（forum.itreetools.org）。 

 

PDA（地理資訊系統）： 

 Windows Mobile 5.0-6.5作業系統 

 240*320 的螢幕解析度 

 

GPS 裝置需求（Requirements for GPS devices） 

在 i-Tree Streets 專案中收集 GPS 座標資訊是非必需的。具 GPS 功能、執行

Windows Mobile 5.0-6.5作業系統的裝置，或具相容性並配對 NMEA藍芽的裝

置，或一系列的 GPS 裝置皆可能被使用。 

 

i-Tree Streets 使用者已成功使用 Trimble Juno SB、Trimble Nomad、Pharos 

Traveler 525 和 MWg Zinc II。然而，GPS 裝置的功能有所不同，裝置之間的操
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作效果也各有差異。舉例而言，Pharos m619 GPS 不適用於 Streets，因此目前不

建議使用。 

 

你也可使用智慧型手機或平板電腦的 GPS 功能。 

 

安裝（Installation） 

1) 進入此網站（www.itreetools.org）下載軟體，或將 i-Tree軟體安裝光碟放

入 CD/DVD 光碟機中。 

2) 按照螢幕的指示執行 i-Tree setup.exe檔案。根據所需的安裝檔案不同，

這將花幾分鐘的時間。 

3) 按照安裝小精靈的指示以完成安裝（建議安裝在預設路徑）。 

 

你可以藉由點擊 Help > Check for Updates 隨時檢查最新的更新。 

 

使用範例專案探索 Streets（Exploring Streets with the Sample 

Project） 

現在你已經安裝完 Streets，你將看到一個軟體圖示，點擊後即可執行 Streets。

為了讓你探索此程式，我們內建了加州戴維斯（Davis, CA）行道樹的隨機抽樣

普查資料的範例專案。此外，若你對病蟲害檢測模型的報告功能有興趣，一個

IPED範例專案也有內建。 

1) 使用你電腦上的開始選單 > 所有應用程式 > 選擇 i-Tree > 點擊 i-Tree 

Streets以開啟 Streets。 

2) 你將在此路徑 File > Open > Sample Project 找到該範例專案。 

 

在 Input 選單中，你將看到關於你的普查資料、你的城市基本資訊、預算成本

與效益價值的許多自定義欄位。在 View 選單內，你可以切換英制和公制單

位，以及學名與俗名。在 Reports內，你可以檢索效益、結構、更換成本及病

蟲害報告。我們當然會深入解釋全部功能，但現在請先自由探索這些可用的選

項。 

  

http://www.itreetools.org/
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第一階段：開始進行（Phase I: Getting Started） 

 

前期規劃決策（Early Decisions to Be Made） 

開始使用 Streets 工作之前，你必需做出一些決定。在本節中，我們會說明各選

項的一些優缺點以幫助你做出決定。 

 

你有一個現有普查資料，或需另建一個嗎？（Do you have an existing inventory 

or will you need to conduct one?） 

如果你的社區已有一個最近建立的樹木普查資料，且其至少包含樹種及胸高直

徑資料，你可將其直接運用於 Streets。該普查只需依 Streets 的最低需求格式

化，並儲存為一個 Microsoft Access 資料庫。之後的〈普查資料規劃〉將詳細說

明所需結構。補充指南書《Formatting Existing Inventories into Streets》以及輸入

現有普查資料至 Streets 的相關資源，可在此網站（www.itreetools.org）的

Resources > Archives 路徑找到。 

 

已有現有普查資料的社區需注意兩個額外事項。第一，如果你只有一個樣本普

查資料（也就是說，你只測量了部份樹木，而非整座都市的樹木），它必需是簡

單隨機抽樣，否則其將無法在內建的模式下執行。第二，Streets 提供你都市林

效益與結構的即時概況。如果你的普查資料不是最新的，你所得到的結果將無

法反應現在的狀況，因此你應考慮建立一個新的普查資料。 

 

如果你需要建立一個新普查資料，你會測量你研究區域內的每一棵行道樹還是

進行隨機抽樣？（If you need to conduct an inventory, will you measure every 

street tree in your study area or carry out a random sample?） 

如果你沒有普查資料，你必需建立一個。此普查可以是一個完整普查資料，至

少涵蓋社區內所有行道樹的樹種及胸高直徑，或是一個抽樣普查資料。在抽樣

普查資料中，街道區段（或線性樣區）按照統計學的隨機抽樣規則選擇，所有

被選擇地段的行道樹都會記錄至普查資料中。抽樣普查資料一般包含整體街道

樣本的 3到 6%，取決於社區大小及街道之間的差異。此抽樣通常會產生 10%

的全市樹木個數標準差。 

 

一個完整的普查資料為你的都市林提供更全面的概況，也是日常工作和未來規

劃的良好基礎。另一方面，抽樣普查資料更快、更便宜，且可提供基本數據以

供決策需求，但通常不能用於每日的管理作業。你必需衡量社區的資源與需

求，以決定哪種普查資料較為適合。 

 

如果需要一個新普查資料，你將使用（a）智慧型手機、平板電腦或其它具網路

功能的行動裝置（b）Streets PDA 工具（c）手動輸入資料的紙制表格，何種方

式收集 Streets相關資料？（If a new inventory is needed, will you collect data 

http://www.itreetools.org/
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using (a) the Streets webform on a smartphone, tablet, or other web-enabled mobile 

device, (b) the Streets PDA tool, or (c) paper forms for manual data entry?） 

i-Tree v5.0 包含一個非常重要的更新：普查資料現在可以在具網路的智慧型手

機及平板電腦（以下簡稱為行動裝置）上建立。Streets 行動裝置功能不是從商

店下載的 app，它是一個基於網路的普查資料收集表格。這意味著該功能只要

求裝置的網路瀏覽器能與 HTML 5 相容。相容的瀏覽器包括最新版的 Chrome

和 Firefox（Android 安卓手機及平板電腦），Safari（iPhone和 iPad），以及

Internet Explorer 9和 10（Windows 手機和平板電腦）。IE 瀏覽器在離線緩存上

有能力限制──收集資料時，使用者必需保持網路連線。因此，如果使用 IE，

你應準備經常將資料從你的行動裝置傳送到伺服器，並了解若是失去資料連

接，最近一次的上傳作業將失敗，所有資料都將同時遺失。 

 

有關相容裝置的最新清單，請參閱 i-Tree論壇（http://forum.itreetools.org）。 

 

除了行動網路表格之外，Streets v5.0 將持續支援使用 PDA建立普查。PDA應

用程式跟 Streets 十分相像。它可以按照你的城市普查需求調整、易於使用，只

要點擊一下即可上傳資料。PDA應用程式能在各種運行Windows Mobile 5.0-6.5

作業系統的手持裝置執行。有關相容裝置的最新清單，請參閱此網站

（www.itreetools.org）Resources > Manuals and Workbooks 內的〈System 

Requirements and Installation Document〉。 

 

如果你的團體缺少使用 PDA或行動裝置的經費，或你想使用另一種方法，那也

可以。普查可以用紙制表格、專門的普查工具、電子表格等建立。使用易於操

作的數據輸入表格，紙制表格的樹木資料可以直接輸入到 Streets 中。用其他方

式建立的普查，最後必需以特定格式儲存成一個 Microsoft Access 資料庫。你可

以複習之後的〈普查規劃〉章節，了解規劃普查所需的資料種類。 

 

收集一般資料（Gathering General Data） 

Streets 可以為你的都市自定義許多資訊，包含效益價格（例如 1千瓦小時電力

或 1噸二氧化碳的價格）、預算資料以及都市基礎建設資訊。某些欄位，例如效

益價格，Streets 已替你的地區內建預設資料，該資料可被編輯以符合你的社

區。其它欄位可自行選擇是否輸入資料，增加資料欄位將產生更有用的結果。

在本節中，我們將說明自定義欄位，提供工作表以幫助你收集資訊。以下的每

個工作表代表一個 Streets 資料輸入視窗，也是最後輸入資料之處。 

 

定義都市資訊（Define City information） 

Streets 將記錄平均收益和成本，並計算幾個關於樹冠的數值。如果你對此訊息

感興趣，使用 Define City（都市定義）工作表收集必要的資訊。 

 

http://forum.itreetools.org/
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都市定義工作表：Total municipal budget（總市政預算）、Population（人口）、Total land 

area（總土地面積，單位平方英里）、Average sidewalk width（人行道平均寬度，單位

英尺）、Total linear miles of streets（總行道長度，單位英里）、Average street width（行

道平均寬度，單位英尺） 

 

定義成本資訊（Define Costs information） 

透過使用基本普查訊息，Streets 會計算你的都市林所提供的效益。為了算出此

效益的效益成本比率（一個有價值的公共政策工具），需要全市行道樹管理的相

關成本數據。如果你對比較你都市林之效益與成本感興趣，使用 Define Public 

Costs（定義公共成本）工作表收集必要的資訊。由於效益為年度總結，全市行

道樹管理的相關成本數據也應是年度值。別忘記包含其他部門的樹木相關成

本，如人行道的維修費用或訴訟費用。 

 

有些社區希望分開公共與私人樹木的成本費用，分別計算效益成本比率。例

如，由地產擁有者付費維護的公共道路樹木，與使用公有資金維護的公共道路

樹木。如果你將在普查中區分公共及私人樹木，你可以使用 Define Costs（定義

成本）工作表的 Private Costs（私人費用）欄位，以估算私人樹木的成本。 

 

 

定義成本工作表：Annual planting（年度種植）、Annual pruning（年度修剪） 
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定義成本工作表：Annual tree and stump removal and disposal（年度樹木及殘幹的移除

與處理）、Annual pest and disease control（年度病蟲害防治）、Annual 

establishment/irrigation（年度種植與灌溉）、Annual price of repair/mitigation of 

infrastructure damage（年度維修/緩解基礎建設損壞的價格）、Annual cost of litter/storm 

clean-up（年度廢棄物及風暴後的清理費用）、Average annual litigation and settlements 

due to tree-related claims（年度與樹相關的訴訟及財產授予之平均索賠）、Annual 

expenditure for program administration（年度計畫實行的支出）、Annual expenditures for 

inspection/ answer service requests（年度檢查/客服支出）、Other annual expenditures（其

它年度支出） 

 

定義效益價格訊息（Define Benefit Prices info） 

Streets 內建單位價格以計算你所在地區之都市林效益。我們鼓勵你更新部份或

全部的效益價格以符合當地的市場狀況。使用 Define Benefit Prices（定義效益

價格）工作表收集資訊。 
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定義效益價格工作表：Electricity （電力，$/kWh）、Natural gas（天然氣，$/therm）、

CO2（二氧化碳，$/lb）、PM10（懸浮微粒，$/lb）、NO2（二氧化氮，$/lb）、SO2（二氧

化硫，$/lb）、VOC（有機揮發物，$/lb）、Stormwater interception（雨水攔截量，

$/gallon）、Median home resale value（每戶轉售價格中位數，$） 

 

普查規劃（Inventory Planning） 

無論你是否已有現存普查或正在建立一個，普查規劃的第一步將決定你需要什

麼資訊。針對普查，Streets 有些較彈性的選項和固定的規則。在本節中，我們

會說明可用於普查的項目欄位，以及各欄位的自訂義與預設類別。若你打算建

立新的普查，此節將幫助你規劃資料收集。若你使用現有普查，此節會說明你

必需用於組織資料的架構。 

 

為了執行 Streets 分析，你的普查必需包含每棵樹的種類及胸高直徑。其它普查

資訊皆非必要。收集越多每棵樹的資料，分析效果越好，包括報告狀況與維護

需求的能力、更換價值、地點、物種資訊和病蟲害偵測。此外，普查明細（行

道地址、GPS 座標和測量日期）也可以收集以幫助管理記錄。根據以下清單，

決定你將採用哪些測量項目。 

 

報告資料（Reportable data） 

Species（物種）：必需。Streets 使用代號辨識物種，而非學名或俗名。為

了大幅減少使用 Streets 所需的時間及精力，你應從一開始就使用 Streets

的物種代號辨識你的樹木。完整的學名及俗名對應的代號清單可在此網

站（www. itreetools.org）的 Resources > Archives > i-Tree Streets & 
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STRATUM Species Codes by Climate Region 找到。Streets 會辨識每個區域

內最普遍的物種。然而，許多其它物種可能會包含在你的都市行道樹普

查中。以不與清單重複的新代號命名這些物種後，你能直接將之輸入

Streets。非樹木代號也可用於追蹤種植地點及樹木殘幹等。 

 

胸高直徑（DBH）：必需。使用直徑範圍或是實際值。 

 

樹木 ID（Tree ID）：必需。每棵樹都有一個獨特的識別號碼。Streets 會

自動產生這些識別號碼。 

 

管理區域（Management zone）：非必需。你可選擇將你的都市劃分為管

理區域或各街坊區域，以提供更多各區都市林結構及效益差異的資料。 

 

行道地段（Street Segment）：樣本普查資料必需。這是一個獨特的編

號，辨識普查中的樹木位於哪個行道地段。如果你使用〈附錄一〉的方

法建立普查，此欄位為 Tiger Line ID。 

 

都市管理（公共與私人）（City managed (public vs private)）：非必需。

如果你選擇分開普查資料中的公共與私人樹木，Streets 會將公共與私人

樹木的效益及成本分開計算。 

 

狀況（Condition）：非必需。狀況類別為樹的健康及結構等（例如，狀

況不佳/好/死亡/垂死）。評估樹木的狀況將幫助規劃未來管理需求，也可

確認不同地區的樹況趨勢。 

 

維護（Maintenance）：非必需。維護分為兩個類別項目：建議維護

（Recommended Maintenance，如對小型樹的例行維護及對大型樹的立即

維護）與優先工作（Priority Task，如清理樹冠和防治病蟲害）。確定樹

木的維護需求有助於未來樹木管理工作，安排維護的順序、種植及預算

編排。 

 

土地利用（Land use）：非必需。土地利用分類描述種植樹木的大面積土

地利用狀況（如住宅區、商業區及工業區）。評估土地利用有助於了解樹

冠的分佈及確認未來種植需注重之不足區域。 

 

現場種類（Site type）：非必需。現場種類確認種植的地點類別（如條狀

及圖案花樣種植）。確定現場種類有助於比較樹木的衝突、建議維護、了

解特定物種的種植地點問題。 

 

衝突（Conflicts）：非必需。衝突類別包括兩個項目：人行道損壞及電線
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衝突。人行道損壞項目測量附近樹木對人行道的破壞（如人行道隆起

3/4-1 1/2 英寸）。電線衝突為樹枝與高架公共設施管線的潛在或現行衝

突。評估這些衝突狀況可預測人行道維修或樹木修剪等的維護成本，並

辨識造成最多衝突的品種。 

 

病蟲害的徵兆與症狀（Pest signs and symptoms）：非必需。病蟲害檢測

項目使用制式及系統性流程，由美國林務局開發，用以評估病兆及病徵

以幫助早期發現病蟲害與病害。該程序要求每棵樹完成約 15個資料項

目，包含檢查樹幹、樹枝及樹葉之壓迫、損壞或不正常生長等徵兆。因

為程序的關係，這些項目無法在 Streets 中自訂義。有關更詳細的資訊，

請參閱病蟲害檢測程序網站（www.itreetools.org/ iped/index.php）或線上

維基 IPED 資源網（http://wiki.bugwood.org/IPED）。 

 

其它（Other 1, 2, 3）：非必需。Streets 最多允許收集 3個附加資料項

目。請注意，此資料為非開放的項目，但必需分為 10個或更少種類。例

如，一個名為「總論」的項目無法被建立，但名為「地標樹」且具有

「是」與「否」類別的項目就可以自由建立。 

 

普查資料細節（Inventory details） 

位置和測量者的資訊以及說明或備註皆可納入 Streets 的記錄。儘管此資訊不會

顯示在報告中，你可以在記錄時查看此訊息並用它分類資料、找到並再次編制

每棵樹木，或在 Streets 外分析。 

行道地址（Street address）：記錄門牌號碼及行道名稱。 

GPS 之緯度及經度（GPS latitude/longitude）：記錄樹木的 GPS 座標位

置。 

測量者（Surveyor）：記錄測量樹木資料的人員或小隊。 

測量日期（Survey date）：記錄測量日期。 

地點（Location site）：記錄種植地點相關的建築物地址（如前、後、左

及右側）。 

地點代號（Location number）：記錄樹的位置以區分同地址的眾多樹木

（如順著車流方向以連續號碼命名樹木）。 

 

定義每個項目類別（Defining categories for each field） 

以上說明的普查項目在 Streets 內皆有預設類別選項。除了病蟲害檢測項目之外

的所有預設項目皆可自訂義以符合你的需求。以下的工作表列出每個預設項

目，空格可填入你決定收集的自訂義項目。 

  

http://www.itreetools.org/
http://wiki.bugwood.org/IPED
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定義胸高直徑類別工作表（Define DBH Categories worksheet） 

如果你決定以等級測量胸高直徑而非確切數值，你需輸入每個等級對應之數值

範圍。 
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定義管理區域工作表（Define Management Zones worksheet） 

如果你將都市劃分成各管理區域或街坊地區，輸入它們的名稱（如果需要的

話），如果有更多區域，使用額外的工作表。 
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定義狀況工作表（Define Conditions worksheet） 

如果你打算收集關於樹木狀況的普查資料並更改預設選項，你必需在此定義代

號。替代因子百分比（Replacement factor percent，RFP）使用 CTLA 方法計算

樹木的替代值，反映特定條件下典型樹木的相對結構完整性及健康。以下提供

適當的 RFP 以符合你的狀況。 

 

 

Dead or dying（死亡或垂死）、Poor（虛弱）、Fair（尚可）、Good（好）。 
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定義維護工作表（Define Maintenance worksheet） 

如果你決定收集與樹木維護建議或優先工作相關的的資料並更改預設選項，你

必需在下方定義代號。 

 

 
None（無），Small tree (routine)（一般小型樹），Small tree (immediate)（緊急的小型

樹），Large tree (routine)（一般大型樹），Large tree (immediate)（緊急的大型樹），

Critical concern (public safety)（重要議題，公共安全）。 
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Stake/train（樹樁/下擺物），Crown clearing（樹冠清潔），Crown raising（樹冠生長提

高），Crown reduction/thinning（樹冠減少/疏伐），Remove（清除），Treat pests/disease

（病蟲害/疾病處理情形）。 
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定義土地利用工作表（Define Land Use worksheet） 

如果你決定收集與土地利用相關的資訊並更改預設選項，你必需在下方定義代

號。 

 

 

Single family residential（單戶住宅），Multi-family residential（多戶住宅），Small 

commercial（小型商業用地），Industrial/large commercial（工業用地/大型商業用地），

Park/vacant/other（公園/未利用土地/其它） 
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定義現場類別（Define Site Type worksheet） 

如果你決定收集與現場類別相關的資訊並更改預設選項，你必需在下方定義代

號。 

 

 

Front yard（前院），Planting strip（條狀種植），Cutout（圖案花樣種植），Median（中

央），Other maintained locations（其它維護地點），Other unmaintained locations（其它未

維護地點），Backyard（後院）。 
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定義衝突工作表（Define Conflicts worksheet） 

如果你決定收集與人行道損壞和公共管線衝突相關的資訊並更改預設選項，你

必需在下方定義代號。 

 

 

（單位英寸） 

 

 

No lines（無管線），Present and no potential conflict（有管線但是沒有潛在衝突），

Present and conflicting（有管線且有衝突）。 
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定義其它一工作表（Define Other 1 worksheet） 

如果你決定自訂義其它一的類別，你必需在下方定義代號。 

 

 

Title of category（類別標題）。 
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定義其它二工作表（Define Other 2 worksheet） 

如果你決定自訂義其它二的類別，你必需在下方定義代號。 

 

 

Title of category（類別標題）。 
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定義其它三工作表（Define Other 3 worksheet） 

如果你決定自訂義其它三的類別，你必需在下方定義代號。 

 

 

Title of category（類別標題）。 
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建立抽樣樣本（Creating a Sample） 

如果你沒有現存普查資料，且已決定建立一個非完整的樣本普查資料，下一個

步驟是設計一個街道區段隨機抽樣。這能以多種方式完成，其中之一會在〈附

錄一〉說明。很重要的是，任何隨機抽樣方法皆需遵循線性街段，以與 Streets

模型相容。 

 

一般而言，樣本普查資料涵蓋全體街道區段樣本的 3-6%，根據社區大小及街道

差異而有所不同。此抽樣會產生 10%的全市樹木個數標準差。下方的一般準則

可作為決定抽樣樣本大小的基準： 

 

 社區人口數 50000以下時，樣本大小為全體街道英哩或區段的 6%。 

 社區人口數 50000-150000 時，樣本大小為 5%。 

 社區人口數 150000-250000 時，樣本大小為 4%。 

 社區人口數 250000以上時，樣本大小為 3%。 

 

所有社區的樹木密度、行道長度及人口等特徵均不同，因此沒有統一的抽樣密

度。最後，你仍需根據結果的使用方向，決定樣本大小及可接受的標準差範

圍。 

 

無論你使用哪種抽樣方法建立你的樣本，最後結果應是街道區段的簡單隨機抽

樣。此外，你必需知道你研究區域內的總街道區段數量。如果你將研究區域劃

分為管理區或是街坊區，你必需知道各區域的總街道區段數量。在下方工作表

上，輸入各區域或都市的總街道區段數量。 

 

注意：為樣本普查資料收集資料時，有幾件事情必需注意。〈第三階段〉將針對

這點討論。 
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抽樣樣本工作表（Sample worksheet） 

如果你已將都市劃分為管理區或街坊區，且正在建立一個樣本普查資料，填寫

各區域的總區段數量（不是抽樣數量）。如需要更多區域，使用額外的工作表。

如果你沒有使用管理區，在下方的區域 1（Zone 1）輸入全社區的街道數量。 
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建立街區清單（Creating a List of Streets） 

如果你決定建立一個完整普查資料，並擁有計畫區域內的全部街道清單，這將

簡化資料的收集。在 Excel 建立的 .csv 檔文件中的每一排填寫一個街道名稱，

或在Word、Notepad、Wordpad建立的 .txt 檔文件中的每一行填寫一個街道名

稱。 

 

格式化現有普查資料（Formatting Existing Inventories） 

如果你正在使用現有普查資料，你必需格式化你的資料以符合 Streets 的要求。

最後結果需為一個 Microsoft Access 資料庫，至少包含物種及胸高直徑項目，但

可額外包含表一（Table 1）的 28個項目或病蟲害調查表中的所有項目（見〈附

錄三〉）。該 Access 文件可任意命名，但資料庫內的表格需命名為

STRATUM_Inventory。 

 

格式要求如下： 

1) 你需包含你擁有資料的項目欄位。例如，如果你只有物種及胸高直徑的

資料，你的資料庫只需包含這兩欄。 

2) 項目名稱一定要符合表一（Table 1）所示，檢查拼字錯誤。 

3) 你的資料一定要符合表一（Table 1）的格式。例如，物種代號

（SpCode）項目需為文字格式（text），胸高直徑項目則為數字

（number）格式。 

4) 沒有資料的欄位應留以空白或填寫 0。在輸入 Streets 的過程中，可以省

略未在普查資料使用的資料項目。 

 

補充指南書《Formatting Existing Inventories into Streets》，可在此網站

（www.itreetools.org）的 Resources > Archives 中找到，匯入現有普查資料到

Streets 的範例和其它資訊也可在該處找到。 

 

現有的 STRATUM or MCTI 檔案（Existing STRATUM or MCTI projects） 

如果你擁有較舊的 STRATUM 格式資料庫（STRATUM-formatted 

database，.mdb 格式）或大型 i-Tree資料庫（i-Tree Grand Database，.mdb 格

式），這些皆不需重新格式化；他們可以現有形式匯入。事實上，如果你擁有較

舊的 STRATUM 專案（副檔名為 .proj），此檔案本身可直接從 Streets 檔案選單

開啟。 

 

現有的 MCTI檔案（Existing MCTI projects） 

如果你有現存的 MCTI檔案並選擇匯入此資料到 Streets 內，此 MCTI.mdb 資料

庫需照上述所示重新格式化以符合 Streets 要求。完成後即可匯入現有資料。我

們建議你使用副本，而非原始的MCTI資料庫。 
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表一（Table 1）為 Streets Access 資料庫所需的項目名稱、格式及類別選項。僅

需包含你擁有的資料所對應的項目。記住，格外注意項目名稱的拼音，名稱必

需完全正確。項目名稱的說明在第 13 至 15頁。 

 

 

  



33 

 

第二階段：開始執行 Streets（Phase II: Getting 

Started with Streets） 

開始收集資料後，你需決定欲收集哪些項目、如何自訂義每個項目的類別，以

及建立隨機抽樣。準備好後，是時候開始執行軟體了。 

 

1) 欲開始執行 Streets，請先點擊你電腦的開始選單 > 所有應用程式 > i-

Tree > 

Streets。 

2) 欲建立新專案，請點擊 File > Open > New project。新專案的視窗將開

啟。 

a. 新建立的專案視窗將要求你命名及選取該專案資料庫儲存的路

徑。在 Database欄位旁，點擊 Specify 按鈕並選擇 Create 

New。瀏覽至該檔案的儲存路徑。於 File Name 輸入檔案名稱

並點擊 Save。 

 

請注意：Specify > Select Existing 選項允許你增加一個新專案

到一個現有的 Streets 專案資料庫。 

b. 在 Project Name中輸入名稱。 

c. 在 Inventory Type的下拉式選單中選擇完整或樣本普查資料。 

d. 在 Year中輸入資料庫建立的年份。 

e. 在 Climate Region 的下拉式選單中，選擇你所在都市的氣候區

域。如果你不確定該選擇哪個氣候區，點擊 View Map（如圖

1）。 

f. 點擊 Finish 以移動到下個視窗。 

3) 在 Define City 視窗的下拉式選單中，選擇你的國家、州、縣郡及都市。 

a. 如果你使用定義都市工作表（Define City Worksheet）收集你都

市的資料，你可以現在輸入資料，或之後藉由點擊 Input > 

City Information 返回此視窗。點擊 OK以移動到下個視窗。 

4) 在 Define Cost 視窗中，輸入你使用定義成本工作表（Define Costs 

worksheet）收集之公共及私人樹木的預算資訊。你也可以在之後點擊

Input > Annual Costs，返回此視窗添加或編輯資料。點擊 OK以移動到

下個視窗。 
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圖 1（Fig.1）Streets 氣候區域 
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5) 在 Benefit Prices 視窗中，輸入你使用定義效益價格工作表（Define 

Benefit Prices worksheet）收集的效益價值，或點擊 OK接受區域預設選

項。你也可以在之後點擊 Input > Benefit Prices，返回此視窗添加或編

輯資料。點擊 OK以移動到下個視窗。 

6) 接著，User Defined Fields 選單將開啟。在 Record 標籤頁中，勾選你決

定收集或已存在於現有普查資料的欄位之框框。如果你將使用 PDA作業

或計畫手動輸入資料，請記住，只有在此勾選的項目可以使用。你可以

點擊 Input > Data Fields 返回此視窗與任何後續視窗，以添加或編輯資

料。 

a. 點擊 DBH 標籤頁，選擇你將依等級或精確值測量。選擇測量

單位為英寸或公分。如果你選擇建立自己的胸高直徑測量等

級，依照你的定義胸高直徑類別工作表（Define DBH 

Categories worksheet），在左側輸入適當的範圍。點擊 Defaults

以還原 Streets 的預設選項。 

b. Zone/Sample 標籤頁有兩個功能：將普查資料分層為區域，並

替各區域或都市內的街道標示代號。如果你在〈第一階段：開

始進行：普查資料規劃〉中，決定將你的都市分成管理區與街

坊區，且在定義管理區域工作表（Define Management Zones 

worksheet）中為它們命名，你應於此裡輸入區域名稱。如需新

增區域，點擊 New 並直接在該欄位輸入此區域的名稱。 

 

若為樣本普查，直接在 Number of Segments 下的欄位輸入樣

本工作表（Sample worksheet）的各區段總數量。如果你尚未

於普查資料劃分區域，在 Zone 1 輸入全市的街道總數量。 

 

﹝請注意：這是可用的總數量，不是抽樣的總數量。抽樣總數

會自動在普查記錄。﹞ 

7) 如果你已建立街道清單以在普查中使用，請點擊 Streets 標籤頁，再點擊

Import List，導航到儲存位置。點擊 Open。或者，你也可以直接在欄位

中輸入街道名稱；ID 代號將自動產生。 

8) 在剩餘的欄位中，輸入工作表內的各自訂義類別或使用預設選項。點擊

Defaults 還原所有類別為 Streets 預設選項。 

9) 編輯完普查資料欄位後，請點擊 OK。你可以點擊 Input選單 > Data 

Fields 返回 User Defined Fields 視窗以隨時變更普查資料欄位。 

 

完成後，你的專案將自動儲存。若未來欲變更資料，你需確保自己經常儲存作

業，路徑為 File > Save Project，或點擊磁碟片圖示（disk icon），或按 Ctrl + 

S。 
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請注意：如果你已決定在紙上建立普查資料，或使用 PDA與行動裝置之外的設

備，你可以前往實地調查。 

 

準備使用智慧型手機及平板電腦收集資料（Preparing for Data 

Collection with Smartphones and Tablets） 

為你的普查資料定義完成項目欄位及類別後，這些資料可傳送至網路上，幫助

你使用行動裝置收集資料。 

 

請注意：如果你將使用病蟲害檢測程序，在開始 PDA配置前，請確定更新。這

將確保你可以裝載來自美國林務局森林健康專家的最新資訊。請選擇選單中

Help 選項下的 Update IPED以進行更新。 

 

傳送專案配置到網路（i-Tree的線上伺服器）（Send project configuration to the 

Web (i-Tree online server）） 

為了傳送你的自訂義資料項目及其它專案資訊至網路上，以供你在行動裝置存

取： 

1) 點擊 Tool 選單 > Work with Mobile。Streets 的Mobile Manager 視窗將

開啟。 

2) 點擊 Submit Project Configuration 後，點擊 Next。 

3) 如果這是一個新專案，下一個視窗將為空白。 

 

請注意：若為現有專案，在此視窗中，你需選擇你任一棵樹木，該樹木的資料

將可於實地使用。這將有助於你的品質管理檢驗。 

 

4) 點擊 Next。 

5) 在最後的視窗中，你會被要求輸入電子郵件地址與密碼。（注意，這些與

你的 i-Tree登入憑證無關。）在你的作業期間，該電子郵件與密碼都與

此專案相關，因此務必將它們記下來。該專案專屬的連結將被寄送至你

所輸入的電子郵件地址。此連結在專案作業期間皆有效，且應與所有資

料收集者共享，以透過網路存取該專案的線上資料收集表格。 

Project email address: _______________________________ 

Project password: ___________________________________ 

 

請注意：為了最有效地管理專案，每一項專案應有一位資料管理者，使用一台

電腦執行 Streets 專案。此人將負責下載所有提交至伺服器的資料，並適當地將

資料匯入 Streets 中。 
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準備使用 PDA收集資料（Preparing for Data Collection with 

PDA） 

為你的普查資料定義完成項目欄位及類別後，如果 PDA是你選擇的普查資料收

集方法，這些資料可傳送至 PDA上。 

 

請注意：如果你將使用病蟲害檢測程序，在開始 PDA配置前，請確定更新。這

將確保你可以裝載來自美國林務局森林健康專家的最新資訊。請選擇選單中

Help 選項下的 Update IPED以進行更新。 

 

檢查狀況及安裝必要組件（Check status and install necessary components） 

準備傳送資料到 PDA時： 

1) 請將其連接到你的電腦。你的電腦必須能辨識你的 PDA。 

 

﹝註：若你的電腦無法辨識你的 PDA，請查看 PDA的說明書。﹞ 

2) 在電腦開啟 Streets 程式，選擇 Tool 選單 > Work with PDA。Streets 

PDA Transfer 視窗將開啟。 

3) 點擊 Check Status。Streets 將檢查你的電腦是否安裝 ActiveSync或

Windows Mobile Device Center、是否有適用的 PDA作業系統與適當

的.NET 版本，以及是否安裝 Streets PDA應用程式。如果沒有，不適當

的版本或缺少的軟將顯示為紅色，且安裝按鈕將亮起。 

4) 點擊 Install 以開始安裝必要軟體。點擊 Yes 以安裝 i-Tree Streets PDA 應

用程式，按照桌機與 PDA螢幕上的指示進行。安裝完畢後，點擊 Check 

Status 以確定所有安裝皆成功。如果有任何版本仍顯示紅色，再點擊

Install，並重複步驟。 

 

傳送專案配置到 PDA （Send project configuration to PDA） 

為傳送你的自訂義資料項目欄位及其它專案資訊到 PDA： 

1) 在桌面上點擊 Tool > Work with PDA。 

2) PDA與你的電腦連線並開始通訊後，點擊 Send Project Configuration to 

the PDA。 

 

你只能經由桌機應用程式變更 PDA的配置（例如，加入新的項目欄位、編輯類

別定義等）。如需變更： 

1) 從 Streets 的桌機介面，點擊 Input 選單 > Data Fields 以進行變更。 

2) 按照上述步驟傳送專案配置到 PDA。這會覆蓋你先前的配置選擇。 

 

請注意：為了最有效地管理專案，每一項專案應有一位資料管理者，使用一台

電腦執行 Streets 專案。此人將負責下載所有提交至伺服器的資料，並適當地將

資料匯入 Streets 中。 
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第三階段：實地調查（Phase III: Out in the Field） 

 

樣本普查資料（Sample Inventories） 

建立不同於完整普查的樣本普查資料時，有幾點事項需注意。首先，你僅能收

集清單上所列區段之樹木的資料。第二，若某個區段沒有樹木，請務必記錄此

資訊，以估算該城市的樹木總數。 

 

若為無樹木區域，請於普查創建記錄並輸入以下資料： 

 樹木編號：即使該樹並不存在，給予一個編號。 

 管理區：若配置專案的過程中你決定追蹤管理區域，記錄該區段所屬

之區域。 

 街道區段：記錄街道區段。 

 物種：輸入該狀況特定之編碼，如「NOTREE」。 

 

由於該樹並不存在，其它資料沒有必要記錄。 

 

請注意：若你在可種植空間及具有可種植空間的無樹木區段採集資料，

「NOTREE」的記錄就不需創建。 

 

若你使用紙制表格或非 i-Tree平台建立樣本普查資料，你可以直接前往該區域

收集資料。若你使用 PDA或行動裝置，指示如下。 

 

使用智慧手機或平板電腦（Using Your Smartphone or Tablet） 

以行動裝置使用 Streets 的幾點注意事項（Some important things to know about 

using a mobile device with Streets） 

欲允許最多裝置存取 Streets，我們選擇以網路表單形式建立行動裝置的功能，

讓你使用裝置的網頁瀏覽器取用，而非以 app形式開啟。這造成使用上的幾個

結果： 

 當你收集資料時，其將暫時儲存於你網路瀏覽器的緩存中。可用的儲存

空間會根據裝置、瀏覽器及設定而有明顯差異。你可以藉由清除瀏覽器

的歷史記錄與資料以增加儲存空間。如果你的瀏覽器歷史記錄或其它資

料用盡儲存空間，你的樣區資料可能會受限成相對較少的記錄。若是清

除歷史記錄及資料，你或許能儲存數百筆記錄。無論如何，資料應經常

上傳至伺服器（見下文）！ 

 對於 Chrome、Firefox 及 Safari 的使用者而言，雖然你將透過網頁進行作

業，但你不被限制於在有網路（無線網路、3G、4G，或 Edge網路）時

才能進行作業。上述的網路瀏覽器緩存將允許你在沒有網路連線時暫時

作業。即便你不需擔心短期的網路斷線，但最後你仍需連線並提交你的
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資料。 

 遺憾的是，這並不適用於 Internet Explorer 的使用者。IE的離線緩存能力

有限，使用者在收集實地資料時需保持連線。因此，如果你使用 IE，你

應隨時準備好將資料從行動裝置上傳至伺服器中，並了解若是失去資料

連接，你最後一次提交的所有資料將會遺失。 

 當你的緩存記憶越來越滿，你將收到一條警告訊息建議你清除瀏覽器的

緩存及歷史記錄。你必須在執行該動作前上傳你的資料，否則資料將會

遺失！ 

 

開始執行（Getting started） 

請記住，Streets 的資料收集功能不是一個 app，是一個網路存取的網路表格，

為你的專案專門設計的。欲存取此網路表格與開始收集資料： 

1) 開啟你的智慧手機或平板電腦的電子郵件應用程式。 

2) 開啟含有你專案的專屬網路表格連結的電子郵件。 

3) 一個新視窗將在你裝置的網頁瀏覽器中開啟。開始前，在測量者框框

（Surveyor box）中輸入使用者名稱，並點擊 Login。 

 

選項選單（Options menu） 

左上方的 gear wheel 允許你開啟 Options 選單，選單內有更進階的操作，例如

上傳資料、重新加載專案配置，以及調整每一頁可檢視的項目數量。 

 

樹/頁數目（Number of trees/page）：開始收集資料或重新檢視現有的資

料時，樹木的數量將使滾動檢視變得困難。欲改變每頁顯示的樹木數

量，調整滑條以設置樹木數量；欲在一個頁面上查看所有樹木，將數值

設置為 0。 

 

重載專案（Reload project）：有時，專案管理者可能會表示有些專案配

置細節已變更，因此需重新加載專案以整合變更。在你上傳任何新資料

後，請點擊 Reload Project 按鈕以完成更新。 

 

上傳資料（Submit data）：經常上傳資料到網路伺服器十分重要！在上

傳資料（Submit data）視窗內，於該頁上方確認欲上傳的樣區數量後，

點擊 Submit button。 

 

新增樹木（Adding trees） 

欲新增樹木到普查時，點擊主頁右上角的加號。你將透過幾個頁面進行工作，

其將在以下詳細描述。在頁面上完成資料輸入後，點擊頁面上的右箭頭以前往

下個步驟。 

 



40 

 

位置（Location） 

ID：自動生成的編碼，以避免重複。 

 

區域（Zone）：若決定將你的城市劃分為管理區或住宅區，從下拉式選

單選擇管理區。 

 

街段（Street Segment）：若為樣本普查，在此輸入街段 ID。若使用〈附

錄一〉的隨機抽樣方法，此為 Tiger Line ID。 

 

街道名稱（Street Name）：若在設定過程中上傳街道清單，從下拉式選

單中選擇街道，也可透過點擊欄位右側的加號，手動輸入街道名稱。 

 

街道號碼（Street Number）：輸入門牌號碼或郵遞區號。 

 

位置編號（Location Number）：若在同一地址或位置有多於一棵以上的

樹木，在此輸入數字區分它們。 

 

位置所在地（Location Site）：相對於建築物地址的種植位置可於此記

錄，例如前、後、右側、左側或使用者自定義的選項。 

 

土地用途（Land Use）：從下拉式選單中選擇最合適的土地利用類型。 

 

地點類型（Site Type）：從下拉式選單中選擇最合適的地點類型。 

 

都市管理（City Managed）：該樹由都市管理，勾選此選框，並取消勾選

私人行道樹的勾選框。 

 

保留位置（Hold Location）：勾選此選框可以保留地址訊息，供該樹與其

餘樹木使用。因此，若為樹木數量較多的區域，可以不用重複輸入地址

資訊。 

 

清除位置（Clear Location）：收集完同一地址的所有樹木，並準備前往

下一個地點時，可以使用清除位置按鈕以刪除所有位置資料，重新開

始。 

 

定位系統（GPS） 

開始（Start）：點擊 Start以開始衛星定位。粗略的經緯度與估算精確度

將顯示。可能需要長達數分鐘的時間以取得足夠數量的衛星達到可接受

的準確度。 
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取得（Capture）：資料精確度達到可接受的水平時，點擊 Capture以保

存這些數值。 

 

座標也可手動輸入。 

 

﹝註：GPS 的精確度取決於設備、訊號與環境因素。欲了解更多資訊，

請諮詢設備製造商。﹞ 

 

物種（Species） 

物種（Species）：使用下拉式選單選擇樹種。點擊下方的按鈕以切換學名

和俗名列表。 

 

若找到一個不在列表中的物種，點擊欄位名稱旁的加號，Add Species 視

窗將開啟。為避免物種重複，你將被要求在此處輸入物種的 4個字母代

碼。（這些物種編碼是 Streets 眾多功能的基礎，但通常不會向具網路功

能之行動裝置的使用者顯示。） 

 

建立物種代碼最簡單的方式，是組合屬名及種名的前兩個字母。例如，

Juglans nigra（黑核桃）就是 JUNI。若收到錯誤訊息，表示物種代碼已

被使用，你可以在代碼後追加一個數字結尾，例如 JUNI_2。該物種代碼

將出現在學名和俗名清單中。（專案管理者可在 Streets 桌機版本輸入正

確的學名和俗名。新配置啟用後，行動裝置將顯示名稱而非代碼。） 

 

DBH：欲準確測量 DBH，直接輸入 DBH之測量值。欲以分級法記錄

DBH，從下拉式選單選擇對應的 DBH分級類別。 

 

木材/葉片情況（Condition of Wood/Leaves）：從下拉式選單中選擇情況

描述。 

 

注釋/註解（Note/comment）：在此欄加註說明。 

 

加註此樹（Note this tree）：若某樹狀況特殊，勾選此選擇框。例如不確

定此樹品種，或專案管理者認定的其它原因。 

 

管理（Management） 

維護建議（Maintenance Recommendation）：從下拉式選單選擇最重要

的維護建議。 

 

優先工作（Priority Task）：從下拉式選單選擇優先工作。 
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人行道損壞（Sidewalk Damage）：從下拉式選單選擇人行道的損壞程

度。 

 

電線衝突（Wire Conflict）：從下拉式選單選擇適當的電線衝突。 

 

其它（Other 1, 2, 3）：從下拉式選單選擇相應的選項。 

 

病蟲害（Pest）： 

初始的病蟲害檢測視窗將要求你評估樹木整體、樹葉/樹枝和分支/主幹是否有病

蟲害跡象。若你針對任一項目回答「yes」，將開啟另一個視窗，詢問你進一步

地定義損害。回答完所有問題後，病蟲害視窗最後將要求你辨識該蟲害。若無

法確定，選擇 Unknown。 

 

有關詳細的現場資料收集程序，請參閱 Inventory Pest Early Detection（IPED）

手冊，在此網站（www.itreetools.org）上的 Resources > Manual and 

Workbooks，或 IPED 維基線上資源網（wiki.bugwood.org/IPED）。 

 

請注意：記住，資料不會自動上傳到伺服器！欲將資料儲存至伺服器，你必需

如上所述提交資料。點擊主頁左上角的齒輪存取已提交的資料。請經常上傳資

料！ 

 

你已準備好前往下一棵樹了。 

 

使用 PDA（Using the PDA） 

欲進入 PDA應用程式，從 PDA應用程式選單（Programs menu）選擇 i-Tree 

Streets。 

 

概述（Overview） 

若你在專案配置階段決定如此，點擊 Log In按鈕以輸入調查日期與調查人/調

查團隊。點擊 Add New Tree開啟五個標籤頁面：Location、GPS、Species、

Mgt與 Pest。這些選項的細節將在稍後詳細說明。Edit Tree 按鈕連接已編制的

樹木清單，你可以選擇任一樹木以編輯相對應的欄位內容，欄位內容同 Add 

New Tree選項所示。Clear ALL Data 可完全刪除已編制的樹木。Backup Data 

to SD Card 提供資料額外的保護，若你的 PDA具此功能，你可以將資料儲存至

一張 SD卡上（高度建議）。Settings 按鈕展示你於桌機配置 PDA階段時選擇的

選項概觀，若你的裝置具有 GPS 功能，且你決定在專案建立時收集 GPS 資

訊，你可以於此配置 GPS 系統。 

 

GPS 配置（Configuring GPS） 
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若你的 PDA具 GPS 功能且欲收集 GPS 資料，從 PDA主選單點擊 Settings 以配

置 GPS。點擊 Scan Ports 以移植 COM Port、Baud Rate、Parity、資料和 Stop 

Bits 欄位。掃描完成後，點擊 Test GPS。若不成功，請參閱 PDA使用者手冊以

調整設置。 

 

添加新樹（Add New Tree） 

Add New Tree 功能是 PDA應用程式的核心。點擊主頁面上的 Add New Tree按

鈕，開啟五個已標籤功能名稱的視窗：Location（位置）、GPS、Species（物

種）、Mgt（管理）和 Pest（病蟲害）。在每個視窗中，你只能輸入 PDA桌機配

置時所選擇的資訊。不需要的欄位將呈現灰色或標記為不必要（Not 

Required）。 

 

位置（Location） 

樹木 ID（Tree ID）：自動生成的編碼，以避免重複。 

 

街段（Street Seg）：若為樣本普查，在此輸入街段 ID。若使用〈附錄

一〉的隨機抽樣方法，此為 Tiger Line ID。 

 

地址號碼（Address #）：輸入門牌號碼或郵遞區號。 

 

區域（Zone）：若決定將你的城市劃分為管理區或住宅區，從下拉式選

單選擇管理區。 

 

街道（Street）：若在設定過程中上傳街道清單，從下拉式選單中選擇街

道，也可透過點擊欄位右側的加號，手動輸入街道名稱。 

 

位置所在地（Location Site）：相對於建築物地址的種植位置可於此記

錄，例如前、後、右側、左側或使用者自定義的選項。 

 

都市管理（City Managed）：該樹由都市管理，勾選此選框，並取消勾選

私人行道樹的勾選框。 

 

位置編號（Location No.）：若在同一地址或位置有多於一棵以上的樹

木，在此輸入數字區分它們。 

 

土地用途（Land Use）：從下拉式選單中選擇最合適的土地利用類型。 

 

地點類型（Site Type）：從下拉式選單中選擇最合適的地點類型。 
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保留位置（Hold）：勾選此選框可以保留地址訊息，供該樹與其餘樹木使

用。因此，若為樹木數量較多的區域，可以不用重複輸入地址資訊。 

 

衛星定位（GPS） 

開始（Start）：點擊開始以開始配對衛星；這可能需要幾分鐘的時間，

也可保持開啟狀態，以避免每棵樹皆需重新配對（請注意，此動作十分

耗電）。 

 

捕捉（Capture）：捕捉功能開啟後，將連續捕捉經度和緯度；理想狀況

下，獲取資料前需已追蹤三個或更多衛星。 

 

接受（Accept）：當座標捕捉記錄穩定後，點擊接受以記錄經緯度座標到

普查中。 

 

停止（Stop）：點擊停止按鈕，可停止收集衛星資料；在記錄樹木之間的

空檔使用該功能，可節省電池用量。 

 

直接輸入（Direct entry）：選擇此選項以手動輸入座標。 

 

﹝註：GPS 的精確度取決於設備和環境因素，如欲了解更多資訊，可諮

詢設備製造商。﹞ 

 

物種（Species） 

物種（Species）：使用下拉式選單選擇樹種。點擊下方的藍色按鈕，切換

學名和俗名清單。若樹木不符合清單內的選項，可直接輸入新物種代

碼。手動輸入的代碼需回到桌機進行物種匹配工作。這將會在〈第四階

段〉進一步說明。物種代碼的完整列表，請參閱此網站

（www.itreetools.org）Resources > Archives下 Climate Region 的《i-Tree 

Streets & STRATUM Species Codes》。 

 

DBH：欲準確測量 DBH，直接輸入 DBH之測量值。欲以分級法記錄

DBH，從下拉式選單選擇對應的 DBH分級類別。 

 

木材/葉片情況（Condition of Wood/Leaves）：從下拉式選單中選擇情況

描述。 

 

注釋/註解（Note/comment）：在此欄加註說明。 

 

加註此樹（Note this tree）：若某樹狀況特殊，勾選此選擇框。例如不確

定此樹品種，或專案管理者認定的其它原因。 
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管理（Mgt，Management） 

維護建議（Maintenance Recommendation）：從下拉式選單選擇最重要

的維護建議。 

 

優先工作（Priority Task）：從下拉式選單選擇優先工作。 

 

人行道損壞（Sidewalk Damage）：從下拉式選單選擇人行道的損壞程

度。 

 

電線衝突（Wire Conflict）：從下拉式選單選擇適當的電線衝突。 

 

其它（Other 1, 2, 3）：從下拉式選單選擇相應的選項。 

 

病蟲害（Pest） 

初始的病蟲害檢測視窗將要求你評估樹木整體、樹葉/樹枝和分支/主幹是否有病

蟲害跡象。若你針對任一項目回答「yes」，將開啟另一個視窗，詢問你進一步

地定義損害。 

 

回答完所有問題後，病蟲害視窗最後將要求你辨識該蟲害。若無法確定，選擇

Unknown。若沒有壓力症狀或病蟲害徵兆，則選擇 None。 

 

有關詳細的現場資料收集程序，請參閱 Inventory Pest Early Detection（IPED）

手冊，在此網站（www.itreetools.org）上的 Resources > Manual and 

Workbooks，或 IPED 維基線上資源網（wiki.bugwood.org/IPED）。 

 

存檔（Save） 

樹木的所有資料輸入完畢後，點擊 Save儲存檔案到普查中。若存檔後需要更

改，返回主頁面再點擊 Edit Tree。選擇欲編輯的樹，點擊 Edit。使用上述視窗

更改資料，再點擊 Save。 

 

請注意：若選擇了病蟲害檢測項目，儲存樹木記錄前，需在每棵樹的主要病蟲

害欄位輸入資料。 

 

你已準備好前往下一棵樹了。 
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第四階段：回到辦公桌：執行 Streets（Phase IV: 

Back at Your Desk: Running Streets） 

 

將資料傳送到 Streets（Transferring Data to Streets） 

使用智慧型手機或平板電腦建立的新普查資料（New inventories conducted with a 

smartphone or tablet） 

欲存取行動裝置上的資料，在電腦桌面開啟 Streets 應用程式。從 Tools 選單選

擇Work with Mobile，再選擇 Retrieve Project Data，輸入之前你所設定的密

碼。 

 

接著，樹木列表將開啟。選擇欲取用的樹木後，點擊 Finish。 

 

使用 PDA應用程式建立的新普查資料（New inventories conducted with the PDA 

application） 

欲傳送 PDA收集的普查資料資料到電腦桌機，需將 PDA與電腦連線。在電腦

桌機上的 Streets 應用程式中，從 Tools 選單選擇Work with PDA。在傳輸實地

資料（Field Data Transfer）區塊，點擊 Retrieve Data from PDA。點擊 OK以

關閉窗口。你的普查資料已傳送至 Streets，PDA資料也已被清除。 

 

PDA的 Clean PDA of Collected Data 功能也能刪除 PDA條目。 

 

手動輸入資料（Manual data entry） 

使用 Streets 在 Input > Records 的資料輸入表單可手動輸入資料。點擊 New 添

加新條目，類似於 PDA內建的表單將開啟。在各標籤頁（一般項目 General、

地點 Location、樹木資訊 Tree Info、管理Management、其它 Other、蟲害

Pest）完成資料輸入。請記住，只有你在配置階段選擇的項目欄位可供使用。 

 

匯入 Access 資料庫普查資料（Importing Access database inventories）： 

如果你有一個現存普查資料，或你使用 PDA以外的電子格式建立普查資料，使

用 File選單中的 Import > Inventory Data 將之匯入 Streets。欲匯入的普查資料需

依照 Streets 的要求格式化並存檔為一個 Microsoft Access 資料庫，而你的樹木

普查資料需儲存於表格中，該表格需命名為「STRATUM_Inventory」。 

 

註：請參考先前〈第一階段：開始進行：格式化現有普查資料〉以獲得更多資

訊。 

 

現有的 STRATUM專案（Existing STRATUM projects） 

較早的 STRATUM 專案（檔名*.proj）可直接透過此路徑 File > Open > Existing 
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Project開啟。若你沒有現存的 STRATUM 專案，但有依照 i-Tree版本 1.x 或

2.x 格式、儲存在 STRATUM 格式的資料庫（*.mdb）或大型 i-Tree 資料庫（i-

Tree Grand Database，*.mdb），你可以透過此路徑 File選單 > Import > 

Inventory Data 使用它。務必參考〈第一階段：開始進行：普查資料規畫〉的

指示定義專案參數。 

 

檢查錯誤（Checking for errors） 

匯入普查資料後，檢查以確定資料正確性是非常重要的。透過此路徑 Input > 

Records 可找到普查資料清單。滾動列表逐項檢查，紅色驚嘆號代表輸入的代

碼不正確或沒有匹配的物種。欲更正錯誤，點擊錯誤的條目開啟手動資料輸入

表單，允許你更改資料。 

 

請注意：某些情況下，錯誤需在 Input > Data Fields 路徑下更正，例如，若你

的普查資料在 Condition 下含有五個資料欄位，卻只有四個資料欄位在啟用狀

態。 

 

專案結合（Combining projects） 

你可以透過 Streets 結合普查資料，例如，將城市分組以獲得一個區域性都市林

概況，甚至構成國家的都市林概況。欲結合普查資料，建立一個新的專案，接

著透過 File選單> Import > Inventory Data 路徑依序加入普查資料。記得使用

Tree普查（Tree Inventory）視窗的 Input > Records 檢查有無代表錯誤的驚嘆

號。 

 

請注意：普查結合功能要求普查資料有類似的結構，包含樣本/完整普查資料、

氣候區與資料欄位。 

 

物種匹配（Species Matching） 

你的普查資料可能包含 Streets 預設列表沒有的物種或物種編碼。在這種情況

下，在上傳資料後，你看到的第一個視窗是定義物種（Define Species）視窗。

（這視窗也可透過 Input > Species 路徑開啟。）無法匹配的物種代碼將被標示

紅色驚嘆號。欲匹配各標記物種： 

1) 點擊行內並輸入相應的學名和俗名。 

2) 在第四欄，指定 SP.值（Assigned Sp. Value），你必需從下方列表選擇最

相配的物種。點擊空白的 Assigned Sp. Value 框框反白。接著，在視窗最

底下的列表中，從下拉式選單選擇最相關的俗名或學名。考慮成熟大

小、樹木類型、外型與科屬關係。若難以直接匹配，可從樹木類型中選

擇。（例如，落葉闊葉樹木樹葉大、常綠針葉樹木樹葉小。） 

3) 若你建立的樣本普查包括無樹街段，忽略這區段的任何物種編碼（例
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如，NOTREE）。維持為無匹配即可。 

 

編輯預設物種（Editing default species） 

你應檢視列表上物種的預設分配。例如，在你所在的地區，紫薇一般可能會被

認為是落葉闊葉小型喬木，但當地條件可能使落葉闊葉中型喬木為更符合的選

擇。任何所列物種皆可改變物種數值，方式如下： 

1) 選擇該行，並透過下拉式選單更改 Assigned Species Value。 

2) 你也可以使用物種定義視窗編輯預設的物種俗名，配合你所在的社區。

直接在欄位內點擊欲編輯的俗名，並輸入以覆蓋當前條目。 

 

無樹物種代碼（Non-tree species codes） 

在眾多普查資料裡，無樹資訊將使用一個物種代碼定義資料。例如，代碼

EPSTL代表一棵大樹的空曠植樹地點，或代碼 STUMP 代表具一個樹樁的潛在

植樹地點。若需這些代碼的報告，這些無樹物種代碼需在 Streets 中定義。 

1) 在物種定義（Define Species）視窗中，針對每一個無樹物種勾選 Non-

Tree? column 的框框（box）。 

2) 接著，點擊 Stocking 按鈕。 

3) Stocking代碼（Stocking Code）視窗將開啟，從下拉式選單選擇每個無

樹代碼並輸入簡要說明。 

4) 如果代碼是指一個特定大小的地點，例如上述的 EPSTL，在 Tree Size欄

位的下拉式選單選擇大小。若大小未被指定，例如上述的 STUMP，選擇

Undefined。 

5) 完成後，點擊 OK。 

 

進行更改（Making Changes） 

你把普查資料上傳到桌機，但發現一些錯誤。也許你的資料收集團隊發現他們

用錯 DBH的皮尺正反面，或誤認 Acer negundo 為白蠟樹（Ash tree）。此時更改

錯誤或在 Streets 中添加全新條目並不會太遲。 

 

資訊庫條目的添加或任何記錄的更改可以透過 Input > Records 路徑進行。 

1) 欲添加一個記錄，點擊 New。 

2) 欲編輯一個記錄，反白欲更改的原記錄，接著點擊 Edit。一個類似於

PDA的視窗將開啟，該視窗的各標籤頁包含一般資料（General data）、

地點（Location）、樹木資訊（Tree Info）、管理（Management）、其它

（Other）和病蟲害（Pest）。添加或更改記錄後，點擊 OK以關閉視窗。 

 

請注意，如果其中有錯誤，或更改時造成欄位定義不連貫，一個紅色的

小驚嘆號將顯示以提醒你檢查。 
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複製記錄（Duplicating records） 

Streets 有一個令人興奮的新功能就是記錄的複製功能，可透過 Input > Records

找到。當所有樹木具有相似屬性，此功能允許你快速添加相同的記錄到資訊庫

裡，避免繁瑣的資料輸入。此外，你還可以透過快速添加假想樹木，觀察城市

中的樹木變化將帶來什麼效益與結構多樣性。 

 

為避免一時添加過多假想樹，最好的辦法是使用新檔名將你的專案另存新檔，

讓你能無後顧之憂地嘗試不同改變。 

 

3) 選擇 File > Save Project As，另存專案並以新檔名命名，例如

「MyTown_ WithALotMoreTrees（我的城市_多樹版本）」。接著，選擇

Input > Records，反白欲複製的記錄，再點擊 Duplicate。 

4) 一個彈跳視窗將詢問你需複製多少份，輸入所需的數字，點擊 OK。 

5) 返回到 Reports 即可看到效益與都市林結構受到的影響。 

 

複查實地資料（Rechecking Data in the Field） 

某些狀況下，你可能會發現你需回到現場複查普查條目。（例如，若你發現樹木

的 DBH為 303 英吋，你知道這是錯誤的，但它是 30、3還是 33英吋？） 

 

使用智慧型手機或平板電腦複查資料（Rechecking data with a smartphone or 

tablet） 

1) 選擇 Tools > Work with Mobile，再點擊標示 Submit Project 

Configuration 的按鈕。 

2) 在下一個畫面，勾選欲複查之樹木旁的項目框，點擊 Next。 

3) 輸入建立專案時，所設定的電子郵件地址和密碼。 

4) 點擊 Finish。 

5) 開啟行動裝置上的電子郵件應用程式，點擊從 i-Tree收到的電子郵件內

的網址連結。 

6) 登入後即可檢視你所選擇的樹木。欲編輯樹木資料，只需點擊該樹木並

循著畫面指示進行。 

7) 記得經常提交你的資料！ 

 

使用 PDA複查資料（Rechecking data with the PDA） 

1) 選擇 Tools > Work with PDA，再點擊標示 Select Records to Transfer to 

the PDA 的按鈕。普查清單將開啟。 

2) 勾選相應記錄條目旁的項目框並點擊 OK。PDA與你的電腦連線且

ActiveSync 運行後，點擊 Send Project Configuration to PDA 按鈕。你的

記錄現在應該出現在 PDA上了。 
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成果報告（Reporting Results） 

當你的普查資料已上傳並編輯至滿意，你可以在 Streets 上檢視各式報告。它們

可以被分成四個主要類別：效益成本分析（Benefit-Cost Analysis）、資源結構分

析（Resource Structural Analysis）、替換值（Replacement Value）與病蟲害分析

（Pest Analysis）。 

 

請注意：報告只提供你所收集的相關資料。舉例來說，如果你沒有在普查資料

內編制維護建議，維護建議報告將空白。同樣地，若你沒有為樹木計畫輸入年

度成本資訊（Annual Cost），成本收益率將不被計算。 

 

每個報告內有許多可檢視的選項。透過選擇相應的選項，每份報告可細分為公

有、私有或所有（公有和私有）樹木。此外，透過選擇相應的按鈕，有些報告

可依物種或區域組織內容。選擇完畢後，總結（Summary）報告類型將列出最

常見的物種（物種代表母群體的>1%）；而其它樹木則歸類為其它行道樹

（Other Street Trees）。完整（Complete）報告類型列出所有編制到普查的樹

木，依照佔率與樹木類型排序與分組。 

 

報告可以使用物種的學名或俗名與公制或英制單位。欲使用學名，選擇 View > 

Scientific Name，學名選項勾選標記將在旁顯示。欲返回到俗名，再點擊該選

項一次，將選項標記移除。同樣地，從 View > Metric Units 路徑可將英制切換

為公制。完成這些更改後，點擊 Refresh 即可顯示新格式。 

 

效益成本分析報告（Benefit-cost analysis reports） 

Streets 計算都市林提供的環境與其它效益，但不會考慮每棵樹木產生的經濟效

益。報告中的效益與成本皆為初始估計，因為某些效益與成本為無形或難以量

化的（例如，心理健康、犯罪與暴力等的影響）。另外，對於它們的物理運作過

程與交互作用的有限了解使計算並不精確（例如，附著於樹木葉片的空氣污染

物經雨水沖刷至土壤）。樹木生長率和死亡率的變化非常大，效益與成本皆取決

於現場的具體情況（例如，樹種、生長條件、維護習慣等）。因此，Streets 在針

對特殊地點情況的有限了解下，提供一個概括性的統計──這個在合理範圍內

具不確定性的統計仍將提供一個決策基礎。量化及制定效益價值的方法，現記

載於已發行的 Tree Guides 連載刊物（在 www.itreetools.org的 Resources 中可獲

取相關資訊），該刊物符合 Streets 的氣候地區。成本效益報告包含下列三種：

年效益（Annual Benefits）、管理成本（Management Costs）與年淨效益（Net 

Annual Benefits）。這些皆可在 Reports > Benefit-Cost Analysis 路徑找到。 

 

年效益（Annual Benefits）：可從左側的下拉式選單取得七種報告。效益根據年

度量化，並以資源單位與美元呈現。若為樣本普查，報告將顯示標準差描述不

確定性的程度。完整普查資料的標準差則以 NA表示。 
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能源（Energy）：能源報告簡述都市林對節約能源的貢獻，像是冬季減少

的天然氣用量（以十億焦耳計算），以及夏季減少的空調電用量（以千瓦

每小時或十億焦耳計算）。 

 

雨水（Stormwater）：雨水報告簡述因樹木節流而減少的年降雨雨水徑流

（以加侖或立方米計算）。 

 

空氣品質（Air quality）：空氣品質報告量化黏附於樹木表面的空氣污染

物（O3、NO2、SO2、PM10），及電力使用減少導致的發電廠排放量減少

（NO2、PM10、VOCs、SO2，以磅或公斤計算）。另外也報告因 BVOC

（生物揮發性有機物質）而致的樹木對空氣品質的潛在負面影響。 

 

二氧化碳（Carbon dioxide）：二氧化碳報告簡述二氧化碳在大氣中的減

少量，因樹木的封存、電力使用減少影響的發電廠排放量減少（以磅或

公斤計算）。該計算模型取用樹木死亡與分解時排放的二氧化碳量，以及

維護保養樹木所釋放的二氧化碳量。 

 

碳儲存量（Carbon stored）：上述報告量化二氧化碳的年度減少量，碳

儲存量報告計算都市林中所有樹木生命期間所封存的二氧化碳量（以磅

或公斤計算），所以它不應該計入二氧化碳數值，否則將導致重複計算。 

 

美觀/其它（Aesthetic/other）：美觀/其它報告展示有形和無形的效益，反

映於地產價值的增加（美元）。 

 

摘要（Summary）：摘要報告展示全年總能量（energy）、雨水

（stormwater）、空氣品質（air quality）、二氧化碳（carbon dioxide）和美

觀/其它（aesthetic/other）的效益。效益以美元/每棵樹或整體總美元呈

現。 

 

管理費用（Management Costs）：與行道樹管理相關的支出將以總支出及類別

各項支出呈現。結果以總美元、美元/每棵樹和美元/每人呈現。 

 

年淨收益（Net Annual Benefits）：全市的效益和成本將以各類別金額和總金額

呈現。淨收益以效益減成本計算，並以效益成本比率（效益除以成本）呈現。 

 

資源結構分析（Resource structural analysis） 

資源結構報告提供都市林的即時概況與訂立管理計畫的必要資訊。利用資源結

構和效益成本的統合報告，可以提供短期及長期的資源管理資訊。這份資料報

告將有助於預測未來發展趨勢及需面對的管理挑戰，以實現都市林的永續性。 
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十四份基礎報告可在 Reports > Resource Structural Analyses 路徑獲得。 

 

母群體摘要（Population Summary）：母群體摘要報告包括總結列表與完整物

種普查清單、總樹木數量、各樹木類型數量，與各 DBH預設分級數量。這些

報告協助對全市物種頻率的基本了解，從管理區到 DBH分級皆有。請注意，

尚未匹配的樹木種類代碼將顯示在報告底部的未匹配（Unmatched）分類。 

 

物種分佈（Species Distribution）：物種分佈報告根據物種組成的資料，使用圓

餅圖與表格以數量百分比列出十種最常見物種。這份報告有助於了解物種優

勢。 

 

相對年齡分佈（Relative Age Distribution）：以 DBH等級分類的樹齡資料，使

用圖表與表格以數量百分比列出十種最常見物種。這些報告的重要性在於可用

以確定當前管理需要，以及預期整體數量與各物種個體老化將如何改變該需

求。一個群體中的樹木年齡層分佈將影響目前和未來的成本以及效益流動。不

均勻的群體讓管理人員可以每年皆分配相同的年度管理經費，並確保整體樹冠

覆蓋的連續性。理想的分佈狀況以高比例的新移植樹木抵消開發相關的死亡

率，而年長樹木的比例也隨年齡增長而下降。 

 

重要價值，IV 值（Importance Values，IV）：整體數量大於 1%的所有物種皆有

對應的 IV值透過表格呈現。Streets 的 IV值為三個相對值之平均（樹木總量百

分比、葉片總面積百分比、樹冠覆蓋百分比），範圍為 0到 100，100代表對該

物種的完全依賴。IV 值說明一個社區對特定物種的依賴度以提供功能性效益。

例如，某物種佔整體數量的 10%，但因本身尺寸巨大而有 25%的 IV 值，表示

當此樹木物種數量因病蟲害或疾病而減少時，所造成的影響將比數字呈現的更

顯著。 

 

狀況（Condition）：樹木的木材與樹葉的狀況，使用圓餅圖和表格以數量百分

比呈現最普遍的物種。樹木狀況說明樹木管理成效與特定地點狀態下的樹木相

對表現。 

 

相對表現指數，RPI（Relative Performance Index，RPI）：RPI涉及各品種的

狀況並取之與其它品種互相比較；該資訊使用表格呈現。高於 1的數值表示比

例上狀況相對優良的物種。同樣地，低於 1的數值則表示狀況相對低於平均值

的物種。各物種的 RPI說明其對當地生長條件的適應度與表現。擁有許多狀況

良好的樹木的物種能在成本較低的情況下提供更高的效益，而樹木表現普通或

不良的物種則反之。但請記住，RPI應與物種年齡資料比對，才能提供更完整

的概況。假如，某個物種多數為衰老、對城市貢獻良多但接近生命盡頭的樹

木，該物種的 RPI值將偏低。 
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蓄積水平（Stocking Level）：根據你在 Stocking Codes 視窗所輸入之資料，此

報告呈現蓄積水平及適宜種植地點的資料。蓄積水平報告可辨識優先度高的種

植區域，以及實施策略性植物購買與成本規劃。 

 

維護建議（Maintenance Recommendation）：維護建議以表格形式展現。表格

內包含各物種的建議與所有建議的概論。成果可依 DBH分級或具特定建議之

前五物種列出。這些報告有助於讓管理者了解行道樹的實際修剪和維護需求。

這估算修剪程度的足夠性，並提供有關城市行道樹群體的風險與責任。有問題

的物種將被辨識，而成本規劃變得容易。 

 

優先工作（Priority Task）：最緊要的維護工作根據使用者所定義的類別顯示。

每個優先工作將個別展示在所有工作概論的上方。這些報告依區域和 DBH分

級列出資料；各區域維護需求最高的五個物種也可被列出。這些報告有助於讓

管理者了解行道樹的實際修剪和維護需求。有問題的物種將被辨識，而成本規

劃變得容易。 

 

土地利用（Land Use）：各土地利用的樹木分布使用圓餅圖和表格以數量百分比

呈現。這些報告有助於了解你的都市林在各土地利用類型的分佈，並可用於比

較樹木衝突、維護建議以及特定物種之問題種植地點的了解工作。 

 

位置（Location）：樹木位置資訊使用圓餅圖和表格以數量百分比呈現。這些報

告可用於比較樹木衝突、維護建議以及特定物種之問題種植地點的了解工作。 

 

衝突（Conflicts）：人行道損壞和電線衝突資訊使用表格呈現。資料可依物種或

區域檢視。這些報告有助於了解物種和管理區的當前及潛在基礎設施相關衝

突。 

 

樹冠覆蓋（Canopy cover）：若你在城市資訊（City information）視窗輸入相關

資料，有關城市和街道的樹冠覆蓋程度將使用圖表和表格以英畝/各區域及整座

城市呈現。這些報告有助於比較當前城市樹冠覆蓋及預期樹冠覆蓋程度。 

 

其它（Other）：若你於普查編制階段收集了「其它（other）」資料，該資料將

使用表格按物種以數量百分比呈現。 

 

替換值（Replacement values） 

替換值在樹木根據某種原因需被移除時，估算在現況下替換樹木的總費用。替

換值根據樹木與景觀鑑定師評委會（Council of Tree and Landscape Appraisers，

CTLA）的物種評鑑指南，該指南使用樹幹公式法。CTLA 是廣泛被樹藝師用於

決定景觀樹木替換值的方法，其根據區域物種水準、狀況、景觀位置、樹幹截
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面積以及區域替換成本來考量。各物種的物種水準、替換成本以及物種基本價

值均可在物種評鑑指南內的各參考城市中獲得。因計算結果為近似值，替換值

只是群體的初步估計，而非樹木之間的確定值。 

 

替換值報告有兩種呈現方式：一是以普查中各物種的 DBH 分級，二是各區域

的 DBH分級。這些報告能在 Reports > Replacement Value 路徑取得。 

 

病蟲害分析（Pest analysis） 

病蟲害分析報告使用 IPED程序收集的資料，評估都市林中現有和潛在的病蟲

害威脅。這些報告可在 Reports > Pest Analysis 路徑取得。該分析報告包含分析

樹木記錄的多方面選項，基於病蟲害、症狀和病癥。Pest Review and Sign 和

Symptom Review 選項供你查詢更詳細的分析記錄。 

 

摘要（Summary）：摘要報告使用表格呈現受病蟲害影響的樹木數量及百分比

記錄。 

 

資料匯出（Exporting Data） 

報告匯出（Exporting reports） 

報告匯出有兩個選項。主視窗上的 Export 按鈕供你以三種格式匯出個別報告：

Adobe Acrobat（*.pdf）、Microsoft Word（*.doc）和 Rich Text Format（*.rtf）。

另外，你也可使用 Export Reports dialogue以 Excel（*.xls）格式匯出報告。 

 

欲從已開啟報告視窗匯出單一 PDF、Word或 RTF報告： 

1) 於已開啟的報告視窗中點擊 Export 按鈕。 

2) 從 Save as type 下拉式選單中選擇文件的保存類型（*.pdf、*.doc或

*.rtf）。 

3) 瀏覽至欲保存檔案的位置，並輸入代表此開啟報告的檔名。 

4) 點擊 Save以完成。 

 

欲使用 Export Reports dialogue輸出一個或多個 Excel 報告： 

1) 從 Files 選單中，選擇 Export > Reports；Excel 對話框的匯出報告選項

（Export Reports Selection）將開啟。 

2) 選擇 Browse 以找到欲保存報告的資料夾。開啟的對話框將允許你根據

需求建立一個新資料夾。 

3) 勾選公有、私有或全部的項目框以選定群體子集。你可以選擇任何或全

部子集；若複選，各選項將匯出為單獨文件。 

4) 報告有三個類別可供選擇：效益成本報告（Benefit-Cost Reports）、整體

數量總結（Population Summary）與資源結構分析（Resource Structural 

Analysis）。對於各類別，你可以選擇 All Reports或從單一個報告選擇。
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各類別的個別報告將被一起分組並保存在相同文件中。 

 

普查資料匯出（Exporting inventory data） 

你也可以從 Streets 應用程式中將現存的樹木記錄以表單格式（*.csv）或 xml 格

式（*.xml）輸出。 

1) 點擊 File > Export > Inventory Data 

2) 從 Save as type 下拉式選單中選擇欲保存的檔案類型（*.csv 或*.xml）。 

3) 3.瀏覽至欲保存文件的位置，並輸入代表此記錄的檔名。 

4) 點擊 Save以完成。 

 

列印報告（Printing reports） 

Print按鈕允許使用者列印開啟的任何報告。另外，你也可選擇 File > Print執

行此動作。 
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附錄一：隨機街段工具書（Appendix 1: Random 

Street Segments Workbook） 

以下指示將幫助任何專業程度的人員創建隨機 i-Tree Streets（STRATUM）樣本

街段，用於實地資料收集。ESRI ArcGIS 軟體將被使用；依據 ArcGIS 採用的版

本不同，指令也將有所修改。舉例來說，美國人口普查的 TIGER 地圖資料被應

用於整個城市。如欲使用於單一城市區域，請遵循各區域的基本指示。 

 

這些指示由兩個基本步驟組成： 

1) 準備專案區域資料。 

2) 產生樣本街段。 

 

完成上述步驟後，你已創建了下列： 

 關注區域的多邊形（polygon）地圖圖層 

 隨機街段線性（line）地圖圖層 

 

提示： 

 這些指令需在 ArcView 級別下使用 ArcGIS 的基本功能。無須使用任何

擴充軟件。 

 進階 GIS 使用者可主要關注下方列點條列的準備步驟概觀，特別注意區

域名稱與類型等區域的細節指示。 

 對於進階 GIS 使用者：在區域基礎分析時，創建完隨機樣本區段分層

後，疊加區域多邊形分層以分割區域交界處。 

 若有需要，從地圖記錄提供者取得投影/座標系統與地圖單位資訊。 

 AOI樣本為大型多邊形，如城市邊界、公園區域或者是個別管理區。 

 ESRI shapefiles、覆蓋或地理普查皆可使用。Shapefiles 非常容易上手。 

 建立良好的資料管理習慣：放置原始資料的資料夾、放置匯出資料的資

料夾、有邏輯地命名資料夾等。 

 定期地在完成步驟期間，將你的作業保存為 ArcGIS *.mxd 專案。 

 下載資料時，你可能需關閉網頁瀏覽器中的彈跳視窗。 

 

常用工具（Common tools）： 

 

開啟項目（Open Project） 

 

選取（Select） 
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添加資料（Add Data） 

 

 

專案區域資料的準備 

概觀（Overview）： 

 取得可呈現你專案的多邊形關注區域（AOI）的 GIS 地圖圖層。 

 取得可呈現你專案的街道中心線的 GIS 地圖圖層。 

 在 ArcView、ArcEditor或 ArcInfo 級別下啟動 ArcGIS 中的 ArcMap 應用

程式。 

 保存一個*.mxd 專案檔案，並選擇名稱和檔案位置。 

 加載 AOI和街道地圖圖層到視圖中。 

 如有需要，請從現有的其它任何項目中，選擇最能代表你專案區域的特

定多邊形 AOI。 

 匯出選定的多邊形 AOI。 

 如有需要，選擇（或剪下）你 AOI中的街道線。 

 匯出所選擇的街道線。 

 

結果（Results） 

 由一個或多個多邊形組成的 AOI地圖圖層。 

 相關街道線地圖圖層。 

 

 

詳細說明（Detailed instructions） 

1) 首先，你需取得描述你 AOI的 shapefile。可能的來源包含當地政府或學

校 GIS 部門或網站上的資源，像是 ESRI’s Free Data

（http://www.esri.com/data/free-data）: 例如，你可以使用美國人口普查

TIGER 地圖資料，以獲取縣市的 shapefiles： 

a) 欲取得美國人口普查 TIGER 的縣市地圖資料，滾動至網頁

上的「下載資料（Downloadable Data）」。 

b) 點擊 Census 2010 TIGER/Line Data 連結。 

c) 在人口普查網頁中，點擊 Download by Type下方的

Download。 

d) 在「選擇圖層類型（Select a layer type）」下選擇縣市分

區。 

e) 在「2010年縣市分區（County Subdivision 2010）」中選擇

合適的州別。 

f) 選擇合適的縣市，點擊 Download。 

http://www.esri.com/data/free-data
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g) 在系統提示時儲存下載的檔案並解壓縮至你的作業目錄或

容易再訪的位置。 

2) 你仍需要道路中心線的 shapefile。欲從從美國人口普查 TIGER 地圖資料

中取得這些資料，在網頁上滾動至「資料下載（Downloadable Data）」。 

a) 點擊 Census 2010 TIGER/Line Data 連結。 

b) 在人口普查網頁中，點擊 Download by Type下方的 Web 

Interface。 

c) 在「選擇圖層類型（Select a layer type）」選擇 Roads。 

d) 在「所有道路（All Roads）」選擇適當的州別和相應的縣

市。 

e) 在系統提示時儲存下載的檔案並解壓縮至你的作業目錄或

容易再訪的位置。 

3) 啟動 ESRI’s ArcMap 應用程式。 

4) 使用 Add Data 按鈕，瀏覽並加載 TIGER County Subdivisions 和 Line 

Features – Roads 地圖圖層到當前視窗。若出現一個「未知空間參考

（Unknown Spatial Reference）」的訊息，點擊 OK以移動到下一步。 

5) TIGER 城市分區資料由縣市組成，通常包括多個多邊形地點。使用

Select工具從螢幕上顯示的多邊形 AOI中選取你的特定多邊形 AOI。細

讀屬性表或使用功能標籤的功能，以幫助你在必要時識別你的多邊形

AOI。 
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6) 匯出選定的多邊形 AOI到一個單獨的地圖圖層，並添加匯出圖層到視窗

內： 

a) 滑鼠右鍵點擊 TIGER County Subdivisions 地圖圖層，並

選擇 Data > Export Data。 

b) 確認 Export下拉式選單已設置 Selected features。 

c) 為多邊形 AOI地圖圖層適當命名並保存。 

d) 系統提示時，點擊 Yes 將匯出的資料添加為地圖圖層到視

窗中。 

7) 查詢 TIGER Road Lines 地圖圖層，以選擇適合的採樣街段： 

a) 在 Table of Contents（TOC）地圖圖層列表中，點擊 Road 

Lines 地圖圖層以選擇它（驗證該地圖圖層在 TOC 中以勾

選，而可於視窗中檢視）。 

b) 從主選單中，選擇 Selection > Select by Attributes。 

c) 在開啟的對話窗口內： 

 

確認 Road Lines 地圖圖層已從下拉式選單中被選擇。 

 

確認所選方法的設置為 Create new selection。 

 

複製並貼上下方的指令句到視窗底部的查詢框內： 

 

“MTFCC” = ‘S1200’ OR “MTFCC” = ‘S1400’ OR 

“MTFCC” =’C3061’ OR “MTFCC” = ‘C3062’ 

 

請注意：2010年的人口普查代碼不同於一般通用的普查代碼。此外，此查詢內

容選擇當地、縣市、州道，但不包含州際公路或州際公路坡道，或私有道路、

街巷、四輪車專用道等。使用者可任意選擇一組設定代碼。 

 

8) 匯出選定的 TIGER 道路線子集到一個單獨的地圖圖層，並添加到視窗

中： 

a) 滑鼠右鍵點擊 TIGER Road Lines 地圖圖層並選擇 Data > 

Export Data。 

b) 確認 Export下拉式選單已設置為 Selected features。 

c) 將所選的街道線地圖圖層命名並保存。 

d) 系統提示時，點擊 Yes 將匯出的資料添加為地圖圖層到視

窗中。 

9) 為使抽樣僅落在 AOI邊界內，適當裁切街道區段。 

a) 透過 ArcToolbox > Analysis Tools > Extract > Clip 開啟裁

切（Clip）工具。 
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b) 在輸入（Input）功能下，選擇適合抽樣的已匯出街道區段

地圖圖層。 

c) 在裁切（Clip）功能下，選擇欲匯出的 AOI地圖圖層。 

d) 在輸出（Output）功能類別下，瀏覽你的工作資料夾，替

裁切的道路圖層命名，檔名為.SHP（例如：myStreets_ 

Clip.shp）。 

e) 將 XY Tolerance框空白。 

f) 已裁切的道路圖層將自動添加至 ArcGIS 的目錄中。 

10) 從主選單中選擇 Selection > Clear Feature 以取消選取多邊形 AOI和

Streets 功能。 

 

結果（Results） 

適合抽樣的多邊形 AOI 地圖圖層和 AOI 相關街道線性圖層。 

 確認多邊形 AOI和 Streets 地圖圖層已加載至地圖視窗。可能需使用滑鼠

右鍵點擊新的 AOI圖層，並選擇 Zoom to Layer。 

 滑鼠右鍵點擊地圖圖層列表中的新 AOI圖層名稱，並選擇 Open 

Attribute Table 以確認你的多邊形 AOI正確且使用屬性欄位，例如「名

稱（name）」。 

 確認街道線已依多邊形 AOI範圍裁切。 

 

 
 

現在，這些街道線已經準備好採樣。 
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街段樣本生成（Street Segment Sample Generation） 

概觀（Overview） 

 添加一個區域到 Streets 資料裡。 

 計算 Streets 資料的隨機數目數值。 

 從屬性欄選取期望的街道區段樣本數目。 

 匯出街道樣本資料和地圖。 

 

結果（Results） 

 供實地採樣的隨機街道區段。 

 

詳細說明（Detailed instructions） 

1) 在裁切過的 Streets地圖圖層中，右鍵點擊 TOC中的 layer name開啟表

格。 

2) 使用表格視窗左上角的 Table Options 按鈕，添加一個 Double類型、名

為 RandomSeg 的欄位至裁切完成的 Streets 表格。將 Precision和 Scale

欄位留空。 

 

 

 

3) 右鍵點擊新建的 RandomSeg 欄位標題，並使用 Field Calculator使用

RND函數填滿欄位： 
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4) 填滿欄位後，滑鼠右鍵點擊 RandomSeg 欄位標題，按照升序排序欄

位。 

5) 滾動屬性欄至街道區段的期望數目並選取之： 

a) 點擊欄目中的任一單元格以檢視 Record count box 的記錄

數目。 

b) 找到期望的記錄數目後，按住 Shift鍵，同時使用記錄條目

左側的灰色鈕選取記錄。 

6) 關閉表格視窗並返回至地圖視窗，匯出選定的 Streets 地圖圖層樣本，並

將它們添加到視窗裡： 

a) 滑鼠右鍵點擊已裁切的 Streets地圖圖層，並選擇 Data > 

Export Data。 

b) 確認 Export下拉式選單已設置為 Selected features。 

c) 將所選的 Streets 地圖圖層命名並保存。 

d) 系統提示時，點擊 Yes 將匯出的資料添加為地圖圖層到視

窗中。 

7) 從主要工具欄中，選擇 Selection > Clear Selected Features 取消選取

Streets 設計功能。 

8) 如有需要，開啟新創建的街道樣本屬性欄，並匯出記錄供 Microsoft 

Excel 使用（用於列印等）： 
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a) 點擊 Attribute表格 > Options 按鈕 > Export > All 

records。 

b) 選擇匯出為一個 dBase 檔案，其可用於MS Excel。 

 

 
 

9) 如有需要，列印街段地圖以供規劃和現場使用： 

 

 

 

a) 在地圖視窗中，以名稱欄位標籤街段。 

b) 滑鼠右鍵點擊 TOC 上的標註以重新著色地圖圖層，改善其

視覺觀感。 

c) 切換到 Layout 視圖，並透過上方的 Insert 選單添加地圖元

素，例如指北針與比例尺。 
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d) 從主要工具欄中，選擇 File > Print，並選擇合適的印表機

和紙張。 

e) 非必要選項（Optional）：選擇 File > Export Map 保存地圖

的電子副本。 

10) 非必要選項（Optional）：對於 AOI中的區域，添加區域多邊形圖層。將

街道樣本區段與區域多邊形重疊，以在區域間分割它們並分配各區段合

適的區域屬性。 

a) 透過 ArcToolbox > Analysis Tools > Overlay > Intersect 開

啟相交（Intersect）工具。 

b) 輸出相交街段圖層將具有街段的區域屬性。 

c) 針對各區域使用 Select by location 功能，讓各區域的街道

樣本符合計算。 

 

結果（Results） 

在 LINE的地圖圖層中，隨機街段樣本的期望數目。 

街段樣本屬性資料的 MS Excel 文件。 

紙本化或電子化的樣本區段地圖。 

  



65 

 

附錄二：錯誤排除（Appendix 2: Troubleshooting） 

群體概論報告顯示錯誤的樹木數字（或根本沒有樹木），但其它像是衝突等報告

顯示正確的樹木數量： 

在 New Project 對話框中，由於你錯誤選擇，以致記錄的 DBH分級記錄。從

Input選單中，選擇 Data Fields 並點擊 DBH 選項。變更 Recorded By 選項到

Measurement。 

 

群體概論報告顯示正確的樹木數字，但它們沒有分類到正確的 DBH分級： 

從 Input 選單中，選擇 Data Fields 並點擊 DBH 選項。變更 Measured In 選項

到正確的測量單位（英寸與公分）。 

 

有些記錄顯示物種代號，而非俗名或學名： 

你沒有在定義物種（Define Species）對話框中，配對所有物種代碼。選擇

Input > Species，按照〈配對物種代碼〉的指示。 

 

普查中的已知物種並未顯示於群體概論報告內： 

請確定你已配對所有物種代碼。選擇 Input > Species，按照〈配對物種代號〉

的指示。請注意，群體概論報告有兩種類型：（1）僅顯示數量大於 1%的物種與

其它物種族群（概論）；（2）顯示所有物種（完整）。 

 

選擇蓄積水平報告時，我收到以下訊息：「你的普查中沒有蓄積水平資料」： 

你沒有設定物種代碼供蓄積水平報告記錄。在 Input選單中，選擇 Species 並按

照〈配對無樹物種代碼〉的指示。 

 

群體概論報告有兩個具相同名稱的項目： 

你指定相同的物種名稱給兩個不同的物種代碼。選擇 Input > Species，滾動物

種代碼清單直到你找到具相同物種名稱的兩個不同的物種代碼。 

 

若該二不同物種代碼實際上代表同一物種，你在 Streets 中更正記錄。選擇

Input > Records，在樹木普查（Tree Inventory）視窗中變更個別記錄。 

 

或者，若兩個物種代號有相同俗名（如 QUWI = Quercus wislizeni（加州海岸

櫟）= live oak（活橡樹），以及 QUAG = Quercus agrifolia（加州檞樹）= live 

oak），你可以經 Input > Species 變更俗名，使其更加精確（QUWI = interior live 

oak（室內活橡樹），以及 QUAG = California live oak（加州活橡樹））。 
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附錄三：病蟲害調查表（Appendix 3: Pest 

Protocol） 

如果你施行病蟲害檢測調查，但並未使用 PDA應用程序，你可以使用下方表格

編排你的資料，以使用 Streets 的進階報告。你可以在此網站

（www.itreetools.org）底下的 Resources、IPED網頁

（www.itreetools.org/iped/index.php），以及線上 Wiki PED 資源網址

（wiki.bugwood.org/IPED）找到更多關於此調查表的資訊。 

 

 表一：病蟲害調查表欄位、分類與值。 
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表 2（Table 2）為在普查 PestPest欄位中輸入的病蟲害 ID。病蟲害清單將頻繁地由

森林健康病蟲害專家更新。IPED使用者應經常選擇 Help選單下的 Update IPED選

項，確保使用者使用的是最新的病蟲害清單。 
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